
Experiment HP-4: Skin 
Temperature, Stress, Calming, and 
Embarrassment
Background

It may seem odd that a psychologist would be inter-
ested in the study of skin temperature. However, events 
which take place in the brain influence skin temper-
ature, just like they influence other characteristics that 
you have studied. A peripheral response, like a change 
in skin temperature, can be used as an indicator of brain 
activity, state of mind, or psychological state. Skin 
temperature depends on three types of factors: 

• environmental conditions (clothing, environmental temper-
ature, humidity, and circulation of air);

• individual variables such as genetics, gender, and health;

• cognitive/emotional or psychological states.

When the environmental and individual factors are 
controlled or held constant, skin temperature can still 
vary between 1 and 2 oF, due to variation in a subject’s 
cognitive/emotional or psychological states. 

Temperature Regulation
The folk adage “cold hands, warm heart” is based on a 

fundamental principle of temperature regulation: 
peripheral vasoconstriction (cold hands) is generally 
accompanied by central vasodilation (warm heart). Blood 
vessels are composed of smooth muscle cells which are 
innervated by neurons of the autonomic nervous system 
(ANS). Neurons in the sympathetic branch of the ANS 
release norepinephrine, which causes vascular muscle 
cells to contract and constrict the flow of blood. Neurons 
in the parasympathetic branch of the ANS release 
acetylcholine, which causes vascular muscle cells to 
dilate and enhance the flow of blood. The shunting of 
blood within the body is useful in regulating body 
temperature and meeting the demands of organs in need 
of energy and oxygen. 

Cells that are sensitive to temperature, and respond to 
changes in blood temperature in order to maintain a 
homeostatic body temperature, are located in the 
hypothalamus. A decrease in blood temperature causes 
the generation of signals from the hypothalamus. These 
signals move through the autonomic nervous system to 
cause peripheral vasoconstriction. Vasoconstriction of 
the peripheral circulation shunts blood to the interior of 
the body to keep the body warm. These signals also 
trigger other responses aimed at generating or 
conserving body heat, like shivering. In contrast, an 
increase in blood temperature brings about peripheral 

vasodilation. Peripheral vasodilation increases blood 
flow to the skin. This response, along with sweating, 
cools the surface of the body and reduces the blood 
temperature. 

Individual Differences
If the environment is constant, individual differences in 

skin temperature are attributed to genetics, the presence 
and distribution of adipose (fat) tissue, gender, and 
health factors. In general, females have a lower skin 
temperature than males probably due to the presence of 
cutaneous adipose tissue and lower basal metabolic 
rates. Persons who are very thin or undernourished, like 
women with Anorexia Nervosa, have very low skin 
temperatures in an adaptive effort to preserve body 
energy. Beyond the obvious effect of infection on 
elevating body temperature, a person’s state of health 
can be a factor influencing skin temperature. For 
example, diabetics often have reduced peripheral circu-
lation and lowered skin temperature, particularly at the 
extremities. Another example is Raynaud’s Disease; 
persons with this disease have extremities that are 
excessively cold due to insufficient blood supply.

Psychological States
Individual cognitive and emotional psychological states 

will cause changes in skin temperature. For example, 
events that activate the sympathetic nervous system, 
and lead to a stress response, will cause a reduction in 
skin temperature by a reduction in peripheral circu-
lation. In animals, survival often depends on greater 
muscular and cardiovascular activity; in these cases, 
blood is shunted to the organs that need more oxygen. 
In humans, the stress response that is activated by any 
threat to one’s life or self worth can lead to a collection 
of physiological responses: lowered skin temperature, 
increased heart rate and breathing, increased brain 
activity, increased muscle tension. This is known as the 
“Fight or Flight” response. Physiological responses are 
often accompanied with changes in psychological state, 
like the subjective feeling of anxiety. The opposite 
events occur when the stressful situation passes. 
Parasympathetic activation returns blood flow to the 
periphery, increases peripheral skin temperature, and 
makes the person relaxed.

Blushing is a localized parasympathetic activation that 
is a paradox. When someone is embarrassed or 
attention is drawn to them by others, the person experi-
ences increased blood flow to the cheeks and to the 
chest and throat region. The opposite would seem 
logical since it seems that embarrassment would be a 
stressful trigger of sympathetic activity. The social signif-
icance and the adaptive value of blushing are not known, 
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but some researchers speculate that blushing engenders 
empathy from others. Leary and Meadows (1991) found 
that blushing correlates most strongly with measures 
that reflect concerns with how one is regarded by others. 
Blushing correlates highly with embarrassability and 
according to Shearn, et al. (1990) females tend to blush 
more than males. 

Thermal Biofeedback
A biofeedback paradigm for the treatment of migraine 

headaches uses changes in skin temperature as a 
measure of response to the treatment. The school of 
thought is that migraines are vascular headaches that 
are a result of vasoconstriction and vasodilation in the 
brain. The implication of this theory is that migraine 
headaches can be averted or diminished if persons 
suffering from migraines can learn to regulate blood 
flow. This treatment approach has demonstrated mixed 
success; many theorists believe that relaxation is the 
most successful ingredient, rather than blood flow 
control. Other theorists believe migraine headaches are 
caused by the release of neurotransmitters in the brain, 
so these headaches are considered neural rather than 
vascular. Skin temperature biofeedback can still be 
useful for learning how to relax and reduce the stress 
response. 

Biofeedback is really an operant learning paradigm. A 
person generates a response (usually mental imagery) 
and the physiological outcome is monitored (feedback-
reinforcement/punishment). The feedback influences the 
mental imagery; the person continues the mental 
imagery because it is successful or changes the imagery 
to something that will bring success, like the attainment 
of the desired goal. Through this type of training, a 
person can learn to modify some aspects of both 
voluntary (muscle tension, EEG) and autonomic activity 
(heart rate, skin conductance, skin temperature, 
stomach acid), even though the autonomic nervous 
system was once thought to be outside conscious 
control.

Biofeedback technology has been useful for persons 
with high levels of anxiety. Counselors or therapists, who 
use biofeedback technology, receive advanced training 
in this technique and are usually certified for its use. 

In this experiment, students will perform a set of 
exercises that will:

• measure baseline skin temperature and record the data;

• measure changes in skin temperature during a mild psycho-
social stressor (mental arithmetic);

• measure the effect of calming mental imagery in a 
biofeedback paradigm on skin temperature; 

• test an experimental hypothesis about embarrassability, 
blushing, and gender.

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

TM-100 Temperature probe

GSR-200 GSR amplifier, electrodes, and extension 
cable

IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure T-1-1 in the Tutorial Chapter for the location of 
the USB port and the power socket on the IWX/214.

3 Check Figure T-1-2 in the Tutorial Chapter for a picture of 
the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the labeled socket on the rear of the IWX/214. Use the 
power switch to turn on the unit. Confirm that the red power 
light is on.

Start the Software
1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 
the Windows Start menu, move the cursor to All Programs 
and then to the listing for iWorx. Select LabScribe from the 
iWorx submenu. The LabScribe Main window will appear 
as the program opens.

1 On the Main window, pull down the Settings menu and 
select Load Group.

2 Locate the folder that contains the settings group, 
IPLMv4.iwxgrp. Select this group and click Open.

3 Pull down the Settings menu again. Select the SkinTemp-
LS2 settings file.

4 After a short time, LabScribe will appear on the computer 
screen as configured by the SkinTemp-LS2 settings.

5 For your information, the settings used to configure the 
LabScribe software and the IWX/214 unit for this exper-
iment are listed in Table HP-4-1 on page HP-4-3. These 
settings are programmed on the Preferences Dialog 
window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.
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Temperature Probe Setup
1 Locate the TM-100 temperature probe (Figure HP-4-1 on 

page HP-4-3) and the GSR-200 galvanic skin response 
amplifier, male-male DIN8 cable, and GSR electrodes 
(Figure HP-4-6 on page HP-4-7) in the iWorx kit.

 Figure HP-4-1: The TM-100 temperature probe.

.

 Figure HP-4-2: The TM-100 temperature probe connected to an IWX214.

2 Plug the DIN8 connector on the TM-100 temperature probe 
into the Channel 3 input on the IWX/214 (Figure HP-4-2 on 
page HP-4-3).

3 The GSR-200 galvanic skin response amplifier will be 
connected to the IWX/214 at the beginning of Exercise 4.

Calibration of Temperature Probe
1 Prepare two beakers of water, one at 10oC, and the other at 

40oC. Measure the temperature of the cold water with a 
thermometer just before the TM-100 temperature probe is 
placed in the beaker.

2 Place the tip of the TM-100 temperature probe in the center 
of the beaker of cold water.

3 Type Calibration at <ColdWaterTemperture> in the Mark 
box to the right of the Mark button on the LabScribe Main 
window.

4 Click Record. The output of the TM-100 temperature probe 
on the Temperature channel should reach a stable level 
about twenty seconds after the probe was placed in the cold 
water. Press the Enter key on the keyboard to mark the 
recording. Continue recording

5 Measure the temperature of the warm water with a 
thermometer just before the TM-100 temperature probe is 
placed in the beaker.

6 Type Calibration at <WarmWaterTemperture> in the Mark 
box.

7 While recording the output of the TM-100 temperature 
probe, move the tip of the probe from cold to warm water. 

8 The output of the TM-100 temperature probe on the 
Temperature channel should reach a stable level about 
twenty seconds after the probe was placed in the warm 
water. Press the Enter key on the keyboard to mark the 
recording. 

9 Click Stop to halt the recording.

10 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

 Figure HP-4-3: Recording of TM-100 output used for its calibration.

Table HP-4-1: Settings on the Channel Window 
of the Preferences Dialog Used to Configure the 
iWorx Recording System for Experiment HP-4.

Parameter Uni ts/Ti t le Setting Mode/
Funct ion

Acquis i t ion Mode Chart

Start User

Stop User

Display Time Sec 10

Speed Samples/Sec 200

Channel  A3 Temperature S DIN8

Channel  A4
Skin 

Conductance 
Level

S DIN8
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11 Use the Display Time icons to adjust the Display Time of 
the Main window to display the data needed to calibrate 
the TM-100 probe on the same Main window (Figure HP-4-
3 on page HP-4-3). This section of data can also be 
selected by:

• Placing the one cursor to the left of the mark that identifies 
the output of the TM-100 probe at the first temperature.

• Placing the other cursor to the right of the mark that identifies 
the output of the probe at the second temperature

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar (Figure HP-4-4 on page HP-4-4) to expand 
or contract the time between the cursors to the width of the 
Main window.

 Figure HP-4-4: The LabScribe toolbar. 

12 To convert the output of the TM-100 temperature probe at 
the measured temperatures:

• Place the cursors on the marks that identify the temperatures 
used in the calibration of the TM-100:

• Click on the arrow next to the title of the Skin Temperature 
channel to open the channel menu. 

• Select Units from the channel menu and Simple from the 
Units submenu.

• The Simple Units Calibration window will appear with the 
voltages at the positions of the two cursors already entered on 
the window (Figure HP-4-5 on page HP-4-4). 

• Make sure that 2 point calibration is selected in the pull-
down menu in the upper-left corner of the window. Put a check 
mark in the box next to Apply units to all blocks. 

• Enter the two temperatures used in the calibration recording 
in the corresponding boxes on the right side of the conversion 
equations. Enter the name of the units, oC, in box below the 
pressures. Click OK to activate the units conversion.

 Figure HP-4-5: Simple Units Conversion window for the TM-
100 temperature probe.

Exercise 1: Baseline Skin Temperature
Aim: To measure the baseline skin temperature of the 

subject.

Procedure
1 Select a person from your group to be the subject. Instruct 

the subject to sit quietly and in a position that prevents him 
or her from seeing the computer monitor. 

2 Place the thermistor between the subject’s left index and 
middle fingers, close to their bases. Tape the thermistor to 
the inside of the index finger by placing surgical tape over 
the wires near the tip, not over the tip. Tape the bases of the 
two fingers together so that the tip of the thermistor is 
contacting the skin on the inside of both fingers, and the tip 
is protected from exposure to air currents. 

3 The subject should rest the hand comfortably on his or her 
lap for one minute before beginning the recording.

4 Type Baseline Skin Temp <Subject’s Name> in the Mark 
box to the right of the Mark button. Click Record, click 
AutoScale for the Skin Temperature channel, and press 
the Enter key on the keyboard to mark the recording. 
Continue recording.

5 Type End Baseline in the Mark box. After recording the 
subject’s skin temperature for one minute, press the Enter 
key on the keyboard. Click Stop to halt the recording. 

6 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file. 

Analysis
1 Scroll through the data file and locate the recording of the 

subject’s baseline skin temperature. 

2 Use the Display Time icons to adjust the Display Time of 
the Main window to display the one minute recording of the 
subject’s baseline skin temperature on the Main window. 
This section of data can also be selected by:

• Placing the cursors on either side of the one minute 
recording of the subject’s baseline skin temperature, and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar (Figure HP-4-4 on page HP-4-4) to expand 
or contract the one minute recording to the width of the Main 
window.

3 Click on the Analysis window icon in the toolbar (Figure 
HP-4-4 on page HP-4-4) or select Analysis from the 
Windows menu to transfer the data displayed in the Main 
window to the Analysis window.

4 Look at the Function Table that is above the Skin Temper-
ature channel in the Analysis window. The mathematical 
function, Mean, should appear in this table. The value for 
mean skin temperature is displayed in the table across the 
top margin of the Skin Conductance Level channel.
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5 Once the cursors are placed in the correct positions for 
determining the mean skin temperature in the one minute 
recording, the value for the mean skin temperature can be 
recorded in the on-line notebook of LabScribe by typing the 
name and value of the parameter directly into the Journal.

6 The functions in the channel menu of the Analysis 
window can also be used to enter the name and value of 
the parameter from the recording to the Journal. To use 
these functions:

• Place the cursors at the locations used to measure the mean 
skin temperature.

• Transfer the name of the parameter to the Journal using the 
Add Title to Journal function in the Skin Temperature 
channel menu.

• Transfer the value for the mean to the Journal using the 
Add Ch. Data to Journal function in the Skin Temperature 
channel menu.

7 On the Skin Temperature channel, use the mouse to click 
on and drag a cursor to the left margin of the data displayed 
on the Analysis window. Drag the other cursor to the right 
margin of the same data.

8 Record the value in the Journal using the one of the 
techniques described in Steps 5 or 6.

9 Enter the subject’s mean skin temperature in Table HP-4-2 
on page HP-4-7.

Exercise 2: Mild Psychosocial Stressor & Skin 
Temperature

Aim: To test if the sympathetic nervous system is 
activated by a mild psychosocial stressor.

When the sympathetic nervous system is activated in 
response to stress, a reduction in peripheral circulation 
occurs. This peripheral vasoconstriction leads to a 
reduction in skin temperature.

It is predicted that the subject’s mean skin temperature 
decreases while the subject is doing mental arithmetic. 
During the follow-up period, the skin temperatures of 
some subjects will return to baseline levels. The skin 
temperatures of other subjects may take a longer time to 
return to baseline levels.

Procedure
1 The psychosocial stressor that will be used in this exercise 

is mental arithmetic. Inform the subject of the task that he or 
she will be doing:

• When the subject hears the word Begin, he or she says 500 
aloud.

• The subject mentally subtracts 7 from 500 and announces 
the result aloud.

• The subject continues to mentally subtract 7 from the 
previous result and announce the new result aloud, until he or 
she hears the word Stop.

• The subject should perform this task as quickly and as 
accurately as possible to reach the lowest possible value within 
one minute.

2 Type Begin Mental Math <Subject’s Name> in the Mark 
box to the right of the Mark button. Click Record, click 
AutoScale for the Skin Temperature channel.

3 Press the Enter key on the keyboard as you say the word 
Begin. The subject should begin the mental arithmetic task 
immediately after hearing the word Begin. Continue 
recording.

4 Type Stop Mental Math in the Mark box. After the subject 
has performed the mathematical task for one minute, press 
the Enter key on the keyboard and say the word Stop. 
Continue to record. 

5 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

6 Instruct the subject to sit quietly.

7 Type End Follow-Up in the Mark box. Press the Enter key 
on the keyboard at the end of the one-minute follow-up 
period.

8 Click Stop to halt the recording. 

9 Select Save in the File menu.

Analysis
1 Scroll through the data file and locate the recording of the 

subject’s skin temperature while performing the mathe-
matical task. 

2 Use the same procedures used in Exercise 1 to position the 
data in the Main window, display the selected data in the 
Analysis window, and measure value for the subject’s 
mean skin temperature while performing the mathematical 
task. 

3 Record the value of this parameter in the Journal using the 
one of the techniques described in Exercise 1, and in 
Table HP-4-2 on page HP-4-7

4 Scroll through the data file and locate the recording of the 
subject’s skin temperature during the follow-up period.

5 Repeat Steps 2 and 3 to find and record the subject’s mean 
skin temperature during the follow-up period.

Questions
1 Does the subject’s mean skin temperature decrease during 

the mental arithmetic task?

2 Does the subject’s mean skin temperature increase during 
the recovery period? 

3 Does the subject’s mean skin temperature return to the 
baseline level during the recovery period? If it did not return 
to the baseline level, what percentage of the return did it 
make?

4 Do these results support the hypothesis put forth at the 
beginning of this exercise?
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Exercise 3: Calming Mental Imagery & Skin 
Temperature

Aim: To demonstrate the effect of relaxing mental 
imagery and biofeedback on skin temperature.

After stressful events subside, the parasympathetic 
nervous system is more active. One indicator of 
parasympathetic activity is an increase in peripheral 
circulation through vasodilation, which can be indicated 
by an increase in skin temperature.

In this exercise, the change in skin temperature repre-
sents the degree of relaxation experienced by the 
subject.Therefore, it is predicted that the subject’s mean 
skin temperature will be higher while the subject is using 
mental imagery and biofeedback to enhance his or her 
state of relaxation than during the baseline period. 
During the follow-up period, skin temperatures of some 
subjects will return to their baseline levels. Tempera-
tures of other subjects may take a longer time to return 
to their baseline levels.

Procedure
1 In this exercise, the subject’s goal is to warm his or her 

hands as much as possible using relaxing mental imagery 
and biofeedback regarding the consequences of the 
imagery.

2 Before the beginning of the exercise, instruct the subject to 
select the imagery that he or she will use during the 
biofeedback period. During the biofeedback period, if the 
subject determines that the imagery being used is 
ineffective, the subject can change the imagery employed.

3 There are three phases in this exercise:

• Phase 1: The subject sits quietly for one minute without 
using imagery or biofeedback, and while facing away from the 
computer screen.

• Phase 2: The subject faces the computer screen and 
watches the recording of his or her skin temperature. The 
subject can watch either the recording of the skin temperature 
as it scrolls across the screen or the digital readout of the skin 
temperature on the right side of the Main window. To display 
the digital readout of the subject’s skin temperature, pull down 
the View menu on the LabScribe Main window and selecting 
Voltmeter. Regardless of the temperature display the subject 
watches, the goal of the subject in this phase of the exercise is 
to raise his or her skin temperature.

• Phase 3: The subject sits quietly for one minute without 
using biofeedback, and while facing away from the computer 
screen.

4 Once the seven minute exercise begins, there should be no 
talking in the room. All the members of the lab group, except 
the subject, should leave the room during the five minute 
imagery/biofeedback phase of the experiment.

5 Instruct the subject to prepare for the first phase of the 
exercise. The subject should sit quietly while comfortably 
resting the hand with the thermistor in his or her lap.

6 Type No Imagery <Subject’s Name> in the Mark box to 
the right of the Mark button. 

7 Click Record, and press the Enter key on the keyboard. 
Record the subject’s skin temperature for one minute. Click 
Stop to halt the recording. 

8 Ask the subject to turn and face the computer screen. The 
subject should sit quietly while watching the computer 
screen and comfortably resting the hand with the thermistor 
in his or her lap.

9 Type Imagery/Biofeedback in the Mark box to the right of 
the Mark button. 

10 Click Record, and press the Enter key on the keyboard. 
Quietly leave the room for five minutes as the subject’s skin 
temperature is recorded. 

11 Quietly return to the room at the end of the Imagery/
Biofeedback phase of the exercise, and click Stop to halt 
the recording.

12 Ask the subject to face away from the computer screen. The 
subject should sit quietly while comfortably resting the hand 
with the thermistor in his or her lap.

13 Type No Biofeedback in the Mark box to the right of the 
Mark button. 

14 Click Record, and press the Enter key on the keyboard. 
Record the subject’s skin temperature for one minute. Click 
Stop to halt the recording.

15 Record the subject’s skin temperature for a minute. Click 
Stop to halt the recording.

16 Select Save in the File menu.

Analysis
1 Scroll through the data file and locate the recording of the 

subject’s skin temperature during Phase 1 - No Imagery. 

2 Use the same procedures used in Exercise 1 to position the 
data in the Main window, display the selected data in the 
Analysis window, and measure the value for the subject’s 
mean skin temperature in Phase 1. 

3 Record the value of this parameter in the Journal using the 
one of the techniques described in Exercise 1, and in 
Table HP-4-2 on page HP-4-7

4 Scroll through the data file and locate the recording of the 
subject’s skin temperature during Phase 2- Imagery/
Biofeedback.

5 Repeat Steps 2 and 3 to find and record the subject’s mean 
skin temperature during Phase 2.

6 Scroll through the data file and locate the recording of the 
subject’s skin temperature during Phase 3- No 
Biofeedback.

7 Repeat Steps 2 and 3 to find and record the subject’s mean 
skin temperature during Phase 3.
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Questions
1 Is the subject’s mean skin temperature higher during Phase 

2 - Imagery/Biofeedback than during Phase 1 - No 
Imagery? 

2 Is the subject’s mean skin temperature higher during Phase 
2 - Imagery/Biofeedback than during Phase 3 - No 
Biofeedback? 

3 Was the subject successful at the imagery/biofeedback 
task? The subject is successful at this task if his or her 
mean skin temperature for the imagery/biofeedback phase 
of the exercise is higher than the phases with no imagery 
and no biofeedback. During Phase 3 - No Biofeedback, if 
the subject’s skin temperature does not return to the same 
level recorded in Phase 1 - No Imagery, it cannot be 
assumed the subject learned biofeedback control. Learning 
is demonstrated when the changes in skin temperature can 
be attributed to mental focus and feedback, and not just to 
time.

Exercise 4: Embarrassability, Blushing, and 
Gender

Aim: To measure any change in the subject’s skin 
temperature and galvanic skin response (GSR) during 
an embarrassment task. To relate the subject’s 
responses to the embarrassment task to his or her 
gender and embarrassability.

In this exercise, the data that is collected will help you 
determine if gender and embarrassability influence 
changes in cheek skin temperature and skin conduc-
tance between a baseline task and an embarrassment 
task. An increase in cheek skin temperature indicates 
vasodilation in that area, which could be seen as 
blushing. The skin conductance is being recorded as a 
measure of the amount of autonomic arousal in the 
subject. 

Temperature Probe and GSR Setup
1 Locate the GSR-200 galvanic skin response amplifier, male-

male DIN8 cable, and GSR electrodes (Figure HP-4-6 on 
page HP-4-7) in the iWorx kit.

 Figure HP-4-6: The GSR-200 galvanic skin response amplifier.

2 Plug one end of the male-male DIN8 cable into the female 
DIN8 connector on the GSR-200 galvanic skin response 
amplifier. Plug the other end of the DIN8 cable into the 
Channel 4 input of the iWX/214 (Figure HP-4-7 on page HP-
4-7).

 Figure HP-4-7: The TM-100 and GSR-200 connected to an IWX214.

Calibration of GSR Amplifier
1 Position the baseline of the recording in the center of the 

Skin Conductance Level channel before attaching the 
electrodes to the amplifier:

• Click on the Save to Disk button in the lower left corner of 
the Main window to switch the LabScribe software into 
Preview mode. When LabScribe is in Preview mode, there is 
a red X across the Save to Disk button. In Preview mode, the 
iWorx recording system works without recording data on the 
hard drive or any other storage media.

• Click on the Preview button. Use the offset knob on the GSR 
amplifier to move the output voltage of the amplifier to zero.

• Click on the Stop button. 

Table HP-4-2: Skin Temperature -  Different 
Experimental Conditions

Subject_____________

Exper imental  Condi t ion Skin Temperature (oF)

Basel ine

Mental  Ar i thmet ic

Post-Mental  Ar i thmet ic

No Imagery

Imagery/Biofeedback

No Biofeedback
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2 Before proceeding to the actual exercises, make sure the 
LabScribe software is set to Record mode. Click on the 
Save to Disk button, in the lower left corner of the Main 
window, to change LabScribe from Preview mode to 
Record mode. When LabScribe is in Record mode, there is 
a green arrow on the Save to Disk button.

Note: If the user clicks the Preview button and an error 
window appears the Main window indicating the iWorx 
hardware cannot be found, make sure the iWorx unit is turned 
on and connected to the USB port of the computer. Then, click 
on the OK button in the error window. Pull down the LabScribe 
Tools menu, select the Find Hardware function, and follow 
the directions on the Find Hardware dialogue window

3 The GSR-200 galvanic skin response amplifier is factory 
calibrated so that an output of 1 Volt is equal to 5 microSi-
emens (µS). This calibration factor is programmed into the 
LabScribe recording software by the GSR-A-LS2 settings 
file used in this experiment. To check the programming of 
the calibration:

• Click on the arrow next to the title of the Skin Conductance 
Level channel to open the channel menu. 

• Select Units from the channel menu and Simple from the 
Units submenu.

• The Simple Units Calibration window will appear with the 
values for the two-point calibration of the GSR-200 amplifier 
already entered (Figure HP-4-8 on page HP-4-8).

 Figure HP-4-8: Simple Units Conversion window for GSR-200 
amplifier.

Procedure
1 Each person in your group will be an experimental subject in 

this exercise. Randomize the order in which members of 
your group participate.

2 There are three experimental conditions in this exercise. 
During the exercise, you will also need to enter comments 
to indicate:

• Baseline Task: The subject sits and reads some neutral 
material from the textbook for one minute. 

• Embarrassment Task: The subject performs the embar-
rassment task for a period of one minute. The tasks are 
randomly drawn. These tasks include: 

1. Singing a common nursery rhyme, such as Row, Row, 
Row Your Boat or Three Blind Mice, out loud.
2. Reading a part from a play, as if trying out for the part 
in front of the directors.
3. Reading an expressive poem, out loud.
4. Talking about the most embarrassing thing that ever 
happened to you.

• Post-Embarrassment Task: The subject returns to reading 
quietly from the text for one minute. 

3 Before the subject performs this exercise, he or she should 
go to the sink, wash his or her hands with soap and water, 
and dry them thoroughly. Washing the hands insures that 
surface oils or other substances, which might lower skin 
conduction, are removed. Do not use alcohol to clean the 
fingers, alcohol dehydrates the skin.

4 Connect the GSR electrodes to the BNC connector on the 
GSR-200 amplifier. 

5 The subject should sit with his or her back to the 
computer monitor. Use the subject’s hand which is 
closer to the iWorx equipment. 

6 Attach each GSR electrode to the volar surface of the distal 
finger segment of two non-adjacent fingers; the index and 
the ring fingers are the ones usually used. Attach the 
electrodes with the Velcro straps so that the straps are 
snug, but not overly tight.

7 The subject should rest his or her hand with the GSR 
electrodes comfortably. The GSR electrodes should be free 
from any extraneous pressure and the electrode cable 
should be hanging freely. Instruct the subject not to move 
the hand during the recording process; movement will 
introduce artifacts into the recording. 

8 Attach the thermistor to the subject’s cheek by placing 
surgical tape over the wires near the tip, not over the tip. 
Cover the tip with an adhesive bandage to prevent the air in 
the room from dissipating the heat near the thermistor. Only 
the tip of the thermistor should be in contact with the face. 
The extension cable from the thermistor to the iWorx unit 
can be held by the subject to prevent the thermistor from 
being pulled off the cheek.

9 Type Tonic SCL <Subject’s Name> in the Mark box that is 
to the right of the Mark button. 

10 Click on the Record button. Press the Enter key on the 
keyboard. Since the GSR amplifier was zeroed in the 
Calibration section of this exercise, the value displayed on 
the Skin Conductance Level channel is the tonic skin 
conductance level (SCL) of the subject. This value should 
be between 2 and 20 µSiemens. Record the subject’s tonic 
SCL for one minute.

11 After recording the subject’s tonic SCL, use the offset knob 
on the GSR-200 amplifier to adjust baseline of the recording 
to zero. Continue recording.
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12 Type Baseline Task in the Mark box. Instruct the subject to 
sit quietly and read from a text. Press the Enter key on the 
keyboard. Record the subject’s skin temperature and skin 
conductance level for one minute. Click Stop to halt the 
recording. 

13 Type Embarrassment Task in the Mark box. 

14 Instruct the subject to draw a slip of paper from the 
envelope provided to your group. Each slip of paper has an 
embarrassment task written on it. 

15 Click Record as the subject is reading the task that he or 
she has to perform. Press the Enter key on the keyboard as 
the subject begins the task. Record the subject’s skin 
temperature and skin conductance level for one minute. 
Click Stop to halt the recording.

Note: If the subject is unwilling to perform the embarrassment 
task then have everyone in your group sing Happy Birthday or 
You are My Sunshine to the subject for the one minute. 

16 Type Post-Embarrassment in the Mark box. Instruct the 
subject to sit quietly and read from a text. Click Record and 
press the Enter key on the keyboard. Record the subject’s 
skin temperature and skin conductance level for one 
minute. Click Stop to halt the recording.

17 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

18 Repeat this exercise for each member of your group. Keep 
track of the order of subjects in the Journal.

Analysis
1 Find the beginning of the first subject’s recording of tonic 

skin temperature and conductance level. 

2 Use the same procedures used in Exercise 1 to position the 
data in the Main window, display the selected data in the 
Analysis window, and measure value for the subject’s 
mean skin temperature and tonic skin conductance level. 

3 Record the names and values of these parameters in the 
Journal using the one of the techniques described in 
Exercise 1, and in Table HP-4-3 on page HP-4-9. If you are 
entering values for the means to the Journal using the 
functions in the channel menu, use the Add All Data to 
Journal function to enter the values for the mean skin 
temperature and mean skin conductance level to the 
Journal at the same time.

4 Scroll through the data file and locate the recording of the 
subject’s skin temperature and conductance level during 
Baseline Task.

5 Repeat Steps 2 and 3 to find and record the subject’s 
names and values of the means during the Baseline Task.

6 Scroll through the data file and locate the recording of the 
subject’s skin temperature and conductance level during 
Embarrassment Task.

7 Repeat Steps 2 and 3 to find and record the subject’s 
names and values of the means during the Embar-
rassment Task.

8 Scroll through the data file and locate the recording of the 
subject’s skin temperature and conductance level during 
Post-Embarrassment Task.

9 Repeat Steps 2 and 3 to find and record the subject’s 
names and values of the means during the Post-Embar-
rassment Task.

Embarrassability Rating Scale (ERS)
1 Read each situation in Table HP-4-4 on page HP-4-11. 

Rate how much embarrassment you would be likely to 
feel in each case. Embarrassment is an unpleasant 
feeling of self-consciousness, awkwardness, and a 
desire to escape the situation and the presence of 
others. A rating of 0 indicates no embarrassment at 
all; a rating of 4 indicates extreme or considerable 
embarrassment. Ratings of 1, 2 or 3 lie between those 
extremes. 

2 Circle your rating for each situation. Total your score for all 
ten items. Scores can range from 0 to 40.

Table HP-4-3: Effect of Embarrassment on Skin Temperature and Conductance

Subject__________________ Gender________ ERS__________

Exper imental  Condi t ion Mean Skin Temperature (oC)
Mean Skin Conductance Level  

(µS)

Tonic 

Basel ine Task (1)

Embarrassment Task (2)

Post-Embarrassment Task (3)

Mean Elevat ion (2-1)
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Class Data
1 The recordings from all three task periods of each subject 

should be analyzed using the instructions from Exercise 4.

2 Each subject should anonymously enter her or his gender, 
embarrassability score, mean skin temperature from each 
task, and mean skin conductances from each task on the 
class data sheet.

3 Divide the class results into two groups using the median 
value from the class scores on the Embarrassability Rating 
Scale. Subjects with scores above the median value are 
assigned to the high embarrassability group, and subjects 
below the median value are assigned to the low embarrass-
ability group.

4 Calculate the group averages for the mean skin tempera-
tures and conductances for each experimental condition for 
both embarrassability groups.

Experimental Hypotheses 
Aim: To test three experimental hypotheses regarding 

the effect of gender and embarrassability on blushing 
(measured as changes in skin temperature and conduc-
tance).

Hypothesis 1
Hypothesis 1: Persons who score as “high” on the embar-

rassability scale blush to a greater degree (greater mean 
elevation in cheek temperature) during the embarrassment 
task than persons who score as “low” on the embarrassability 
scale.

1 Compare the group average for the mean elevations in skin 
temperature from the high embarrassability group to the 
group average of the low embarrassability group.

2 Does the high embarrassability group have higher mean 
elevation in skin temperature?

3 Does the class data support Hypothesis 1?

4 How would the results be affected if subjects were not 
“accurate” when they performed their embarrassability 
ratings?

Hypothesis 2
Hypothesis 2: Females blush to a greater degree 

(greater mean elevation in cheek temperature) during 
the embarrassment task than males.

1 What percentage of the female subjects are in the high 
embarrassability group? What percentage of the males are 
in the high embarrassability group?

2 Compare the group average for the mean elevations in skin 
temperature from the female group to the group average of 
the male group.

3 Does the female group have a higher mean elevation in skin 
temperature?

4 Does the class data support Hypothesis 2?

5 How would the results be affected if subjects were not 
“accurate” when they performed their embarrassability 
ratings?

Hypothesis 3
Hypothesis 3: Mean elevations in skin conductance levels 

are correlated to mean elevations in cheek temperature.

1 Plot the mean elevation in cheek temperature of each 
subject as a function of his or her mean elevation in skin 
conductance. Plot all subjects on the same graph. Mark 
points for subjects in the high embarrassability group with 
crosses, and points for subjects in the low embarrassability 
group with circles. 

2 Does mean elevation in skin temperature correlate with 
mean elevation in skin conductance? Is this relationship 
linear? Are the crosses clustered in one region of the graph, 
and the circles clustered in another region of the graph?

3 Are the group averages for mean elevation in skin temper-
ature and conductance higher in the high embarrassability 
group than in the low embarrassability group? Does this 
comparison correlate with the graph?

4 Does the class data support Hypothesis 3?
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Score__________

Table HP-4-4: Embarrassabil i ty Rating Scale

Situat ion Rat ing (0-4)

No Embarrassment Extreme
Embarrassment

People are s inging “happy 
bir thday” to you at  a party. 0 1 2 3 4

You just  knocked over your glass 
at  the table of  an important  
d inner party.

0 1 2 3 4

You f ind yoursel f  in the elevator 
a lone wi th your favor i te 
professor and can’ t  th ink of  
anything to say.

0 1 2 3 4

You’ve just  been cal led on 
unexpectedly by a professor to 
answer a quest ion.

0 1 2 3 4

Compared to everyone else,  you 
seem inappropr iately dressed for  
a social  event.

0 1 2 3 4

You tr ip and fa l l  dropping your 
books whi le walk ing up the stai rs 
to c lass.  

0 1 2 3 4

You are at  a play and i t  is  c lear 
that  the actor has forgotten his 
l ines.

0 1 2 3 4

You have to stand and introduce 
yoursel f  to others on the f i rst  
c lass day.

0 1 2 3 4

Your date spi l ls  spaghett i  sauce 
on his/her c lothes on the f i rst  
date.

0 1 2 3 4

You walk into a bathroom you 
thought was empty at  someone’s 
house and f ind a member of  the 
opposi te sex.

0 1 2 3 4
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